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Creating content for everyone
Easy tips to help ensure your work can be understood by the widest 
possible audience
With remote work and global colleagues, it’s difficult to know everyone’s situation. People are 
managing many different work and personal scenarios, and a few simple actions can help recipients 
get the most out of your content. You’ll not only expand your reach by including people with 
disabilities, you’ll also make your content more readable and compelling for everyone.

It takes all of us to create a more accessible and equitable world. How would 
you know if a colleague is color blind? Are they deaf or hard of hearing?
Do they have a spotty internet connection or noisy work environment?
If you don’t know the answer to these questions, it’s best to work in the 
most accessible and inclusive way possible.

This document contains tips on how to create emails, run Teams meetings, and develop PowerPoint 
presentations that can be easily understood by everyone. We hope you will try them today! 



Email

Ensure readability when using color
Did you know that approximately 1 in 12 men and 1 in 200 women are color blind? 
There are multiple ways to make sure your content is noticed and readable by all.

Ensure that color is not the only means of conveying information
Our first tip is to consider your use of color when crafting emails. Many of us often highlight 
important information in our emails to call attention to it. But colleagues who are color blind might 
not notice certain colors. A simple way to fix this is to include more than color. For example, add 
bold font.

Instead of just using color:
Please respond by this Friday if you’ll attend.

Use color and a different font:
Please respond by this Friday if you’ll attend.

Check color contrast
Text can be difficult to read when its color is too similar to the color behind it. This can be 
challenging for people who are color blind, as well as for people with dyslexia. Increasing the 
contrast will make it much easier for everyone to read. Simply select ‘Accessibility Checker’ in your 
‘Review’ tab. The tool will provide a warning if it detects a problem with the color contrast. 

Insufficient Sufficient



Add descriptive text to images
Descriptive text helps when an image won’t load or if a recipient can’t see the visual.

Have you ever had a slow Internet connection and the images don’t load? Or what 
if a colleague is blind or low vision? You might not know this if you haven’t met in 
person. Using descriptive text (also known as ‘alt text’) helps when your recipient can’t see 
the images you’ve included in your email.

1. Right select your image

2. Select ‘Edit Alt Text’

3. Input copy describing your visual
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Use descriptive hyperlink text
Descriptive hyperlink text helps recipients understand where the link will take them. 
Helpful for colleagues who use a screen reader.

Many of us have probably created a hyperlink that says, ‘Click here’ or ‘Learn more.’ 
However, that’s not very helpful for someone who might be using a screen reader, or for 
anyone who would like to know exactly where the link will take them. Instead, try using 
specific language that tells the reader where the link will take them.

Instead of this Write this

Click here Read our FY22 plan

Learn more Watch the video 
from our meeting

Finally, it’s always a best practice to run Accessibility Checker before hitting send on any 
email. We never know when our email might be forwarded more broadly. You’ll find it 
under the ‘Review’ tab in Outlook.

Pro tip: Run Accessibility Checker before hitting send on any mail.

Just as you check spelling and grammar 
before sending, also check to ensure 
accessibility is addressed so that all 
recipients can understand it.

https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#bkmk_use


Microsoft Teams

Turn on your video
Helps colleagues see your facial expressions, providing important context for 
your message.

Whenever possible, turning on your video enables people to see your facial expressions. This is 
especially helpful for colleagues that are deaf or hard of hearing, or for those who need more 
context for the discussion—for example, if they speak a different language. Remember sometimes 
things like humor or sarcasm don’t easily translate, and people can benefit from additional context. 

There are, of course, times when you may not be able to turn on your video or make a personal 
choice to have it off.

1. Select the video icon
2. Hover over video icon to preview
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Blur your background or use a background image 
Improves focus on the participants and reduces distractions if there is 
movement on screen.

This helps keep the focus on the participants who will appear clear while everything behind them is 
subtly concealed. It also helps reduce distractions if there is activity happening behind some of the 
participants. 

You can do this as soon as you sign into your meeting:
1. Go to your meeting controls and select More actions… Select the three dots. You’ll see them in 

the upper right part of your screen. 

2. Then, select Apply background effects

3. Then select Blur to blur your background or choose from the available images to replace it. 

Also, you can select Preview to see how your chosen background looks before you apply it, and then 
select Apply.

Note: Do not blur background if communicating in sign language.
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Use PowerPoint Live when presenting 
Participants can move at their own pace, turn on live subtitles, use screen 
readers, and high contrast mode.

Using PowerPoint Live when giving a presentation is helpful for many reasons. First, this allows 
everyone in the audience to connect from their device (laptop, tablet, or phone) where they can follow 
along at their own pace. If desired, for example, they can move back through the slides to review 
something, or spend more time on a specific slide, without impacting the presenter. 

The second benefit is that, with the power of AI, everyone in the audience can enable live subtitles 
in their preferred language on their own device. This will not only support participants with hearing 
disabilities, but also assist with language differences and ensure that everyone in the audience is fully 
understanding the discussion.

If you are not using PowerPoint Live, another best practice is to share your slides ahead of time. 

Introducing PowerPoint Live in Microsoft Teams – https://aka.ms/PowerPointLive-Teams

Share your screen and select file 
from PPT Live section

Participants select preferences 
without impacting presenter
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https://techcommunity.microsoft.com/t5/microsoft-365-blog/introducing-powerpoint-live-in-microsoft-teams/ba-p/2140980


PowerPoint

Use more than color to illustrate your concept 
Insufficient labeling and color contrast can impact those who are color blind or 
have dyslexia.

Similar to email, consider your use of color when crafting PowerPoint slides. You may recall that 
approximately 1 in 12 men and 1 in 200 women are color blind. Did you know that about 1 in 10 
people have dyslexia? Both of these groups might find it hard to read your content if color isn’t 
used appropriately. This is especially important when labeling your information. 

In this example, the chart on the left, without the data and titles clearly marked, would be 
challenging for a person who is color blind to read. And, it’s just easier for everyone to have the data 
called out more clearly, as shown on the right. It reduces the cognitive load for all of us when we 
don’t have to think so hard. You could also make things easier using patterns. For example, instead 
of just color, some pieces of the chart might have stripes or dots.

It’s helpful to be specific when presenting data on a slide. Instead of saying, ‘as you can see,’ use 
language that describes what’s on the slide. For example, ‘the pie chart on the right shows that 
grape is the most popular flavor.’ This is helpful to anyone who can’t see the slide.

Also, don’t forget to ensure you have sufficient color contrast. Text can be difficult to read when 
its color is too similar to the color behind it. Increasing the contrast will make it easier to read 
for everyone, not just those who are color blind or who have dyslexia. As with email, use the 
Accessibility Checker to check your color contrast.

Chart with color alone Chart for color blind colleagues Chart with data and titles
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Create slides with proper reading order  
Important for colleagues using a screen reader for a vision or reading disability.

One of the easiest ways to address the reading order on a slide is by using accessible templates. In 
these, proper reading order is built into the slides. 

To do this, open a blank PowerPoint and type ‘accessible’ into the search bar and you’ll be given 
options to choose from.
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Ensure proper reading order with Accessibility Checker
Sometimes a template may not work for your needs, and you’ll want to create a slide from scratch. 
Here’s how to use Accessibility Checker to ensure proper reading order. 

On your slide, click ‘Accessibility Checker’ in the Review tab and then select ‘Reading Order.’ In the 
‘Reading Order’ chart on the right, you can simply drag and drop the content shown or use the arrow 
tabs to get the content in the correct position. If something is decorative and doesn’t need to be 
read, simply uncheck the box. For example, you might have an image or graphic that isn’t pertinent to 
telling the story. 

In order to check your reading order, hit the ‘Tab’ key repeatedly until you’ve gone through all objects 
in the slide. Each time you press the Tab key, the focus moves to the next object that the screen 
reader will read.



Add descriptive text to images 
Descriptive text helps when an image won’t load or if a recipient can’t see 
the visual.

Adding descriptive text to images in your PowerPoint presentations helps the reader know what’s 
important about the visual you’ve selected. If the content isn’t pertinent to the meaning of your slide, 
you can also mark it as decorative, and a screen reader will skip over that. For example, if there are 
shapes or icons on the page that are simply visually appealing, you can mark those as decorative. 

Right select  
your image

Select ‘Edit 
Alt Text’

Input copy describing 
your visual
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Keep Accessibility Checker running in background  

Here’s one last tip to help you find accessibility problems before your PowerPoint presentation is final. 
It can be done in three easy steps. 

1. Click ‘File’ in your menu bar

2. Scroll down and click ‘Options’

3. Select ‘Accessibility’ and you will see this chart giving you the option to keep Accessibility Checker 
running while you work. 

As you work, if an accessibility issues comes up, you’ll see the ‘Accessibility: Investigate’ prompt and 
can fix the problem then and there instead of having to do everything at the end.

File > Options > Accessibility

The ‘Accessibility: Investigate’ 
prompt will help you find 

problems before your deck is final.
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Thank you!
There are many ways to support your colleagues, classmates, friends, and family members with 

disabilities. Here are some additional resources to deepen your knowledge.

Browse accessibility videos from Microsoft - https://www.youtube.com/user/MSFTEnable

Earn your accessibility fundamentals badge  
Explore accessibility fundamental training - https://aka.ms/accessibilityfundamentals

https://www.youtube.com/user/MSFTEnable
https://docs.microsoft.com/en-us/learn/browse/?term=accessibility&terms=accessibility
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